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Criminal Investigation for 
Public Health Professionals 

YOUR NAME HERE 

Presenter
Presentation Notes
NOTES:This set of slides is intended as a template for an experienced criminal investigator – from a local, state or federal law enforcement agency – to speak from in the Forensic Epidemiology course. As a template, they are designed to be customized to be correct for the jurisdiction(s) where the course is being held. You should go through and, as far as possible, answer the questions posed in the bullets, or customize them to local practices and organizations.  Feel free to create more slides, if you need to, to cover the issues in the templates. Also feel free to add additional topics as needed for local use.  Experience has shown, however, that people without a law enforcement background will benefit greatly by hearing about the topics outlined on this template.  You may leave the slides as they are, to prompt you to say the right things about these issues, but we strongly recommend that you customize them. The participants in the course should have a copy of your slides in their notebooks, and you will want to be sure that they take the appropriate information home with them.  This presentation should last approximately 50 minutes, including time for questions and answers. As a result, it may be necessary to remove some of the topics covered. This should be done at the discretion of the local planning committee and the presenter of this slide set.Add your own name as the presenter and your own subtitle if you like. Text that is designed to be replaced or edited is colored in RED.  Other material should be edited or customized as needed. A space is provided in each slide for your organization’s seal or logo. In order to access the area in which the logo will reside, you must go to the slide master. To do this go to the View menu, then select Master, Slide Master. Replace the “Insert seal or logo here” generic logo on the slide master with the appropriate logo for your jurisdiction’s criminal investigation department. This will replace the logo on all but the title slide. To change the logo on the title slide, go to the View menu, then select Master, Title Master. Replace the “Insert seal or logo here” generic logo on the title master with the appropriate logo for your jurisdiction’s criminal investigation department. Make sure all the text is legible (e.g., white on blue background, not red on blue) when slides are complete. To change the color of the text, highlight the text that needs to be changed, go to the Format menu, then Font, then change the color to white. Currently, the date is located in the footer. To change the date from the generic “Date” to the date of the presentation, go to the View menu, then select Header and Footer.  Under footer, replace “Date” with the appropriate date, then select Apply to All. To change the presenter’s name and change the color of the text in the footer you must go to the slide master. To do this, go to the View menu, then select Master, Slide Master. Highlight the generic “Presenter’s name”, change it to the reflect the name of the presenter, then go to the Format menu, select Font and change the color to white. Highlight <footer>, go to the Format menu, select Font and change the color to white.
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Lecture Goals 

• Explain basic terminology 
• Learn about roles of various law enforcement 

agencies 
• Learn about criminal investigative methods 
• Learn about law enforcement operations and 

procedures 

Presenter
Presentation Notes
NOTES:The purpose of this slide is to give the lecture goals for this presentation.
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Law Enforcement 
Investigative Goals 

• Determine how a crime occurred 
• Protect public health and safety 
• Identify and collect all relevant evidence 
• Protect crime scene and preserve evidence for 

use in prosecution 
• Identify, apprehend, and convict perpetrator(s) 

using this evidence 
• Prevent further criminal acts by this 

perpetrator 

Presenter
Presentation Notes
NOTES:The purpose of this slide is to give the goals of a law enforcement investigation.
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Law Enforcement and Public 
Health Goals Compared 

Law enforcement: 
 

• Stop further crimes 
• Protect health and safety 

of public 
• Apprehend and convict 

criminals 

Public health: 
 

• Stop further cases of 
disease and outbreaks 

• Protect health and 
safety of public  

• Build science base for 
future prevention 

Presenter
Presentation Notes
NOTES:This slide compares the goals of law enforcement and public health, showing the commonalities.
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Terminology 

• Case:  the totality of an investigation or a 
person? 

• Suspect: a person under suspicion or a 
person who may be a case? 

• Victim vs. Case 
• Evidence: criminal vs. scientific 

Presenter
Presentation Notes
NOTES:Terminology: Public health and law enforcement differ in their definitions.For public health workers, the word “case” refers to an individual person who has a case of a particular disease. Usually there are formal criteria for deciding medically which ill persons are “cases” of the disease under investigation. An outbreak is made up of one or more, usually many, cases. Most law enforcement workers would use the word “victim” to mean something close to this concept.  For law enforcement workers, the word “case” usually refers to all the activities, interviews, evidence, etc related to one crime or set of related crimes. Most public health workers would use the word “investigation” to convey this concept.  Public health workers may classify people who may be cases of a disease for investigative purposes into possible, probably, suspected, or confirmed cases.  So they may refer to a group of ‘suspects’, who are people who are strongly suspected of having the disease, that is, being cases. To law enforcement workers, of course, “suspect” refers to a person who is suspected of having committed or aided in committing the crime.  Public health and law enforcement workers both collect evidence in the course of their investigations. Such evidence for public health workers may include inspection reports from facilities, interviews with ill and well people possibly exposed to the disease agent, medical records of ill people, historical records of previous cases and outbreaks of this disease, etc. Some but not all of this material can be tagged or secured in an evidence locker, or subject to chain of custody procedures.  
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Local Police (or Sheriff’s 
Office) 

• Roles  
• Field operations, detectives, forensic unit, bomb 

squad, HAZMAT team, etc. 
• Organizational Structure  
• Points of contact 
• Capabilities  

Presenter
Presentation Notes
NOTES:Roles: In criminal investigations, what is role of local vs. county or state police investigators in this jurisdiction? Organization -- how is this force organized – what specialized units are there, how do they relate to patrol officers, and to whom do they report?Points of contact: Provide phone numbers and other contact information for key persons or roles in the organization that public health, EMS, HAZMAT or fire might need to contact.  Capabilities: Describe local capabilities in criminal investigations – e.g., capabilities of local crime lab if any, specialized crime scene unit, how coroner or medical examiner services are provided, are there officers trained in PPE and entry into dangerous settings to gather evidence, sources of backup assistance for investigative activities as needed.  NOTE: Parallel sets of slides are included for local, county and state law enforcement organizations, and for the FBI. The latter are not needed if, as recommended, the appropriate regional FBI WMD coordinator makes the FBI presentation. You may not need all three of the other presentations, depending on the jurisdiction. If the course is being given for a multi-county area with several cities, for example, you may decide to make the city and county slides generic. If the course is being given in a large city with no county police active within the city, you may decide to omit the county slides entirely. In a rural area there may be no city police departments. And so on.  
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One Typical Local Police 
Agency Chief 

Patrol 

Traffic 

Investigations 

Homicide 

Property Crimes 

Support Services 

Tech Services 

Communications 

Crime Scene 

Tactical 

Aviation 

Prof Standards 

Training 

Legal 

Internal Affairs 

Presenter
Presentation Notes
NOTES:If you have one or can create one, show your top-level organization chart here.  If there are multiple police and sheriff’s jurisdictions, show a map of which force has responsibilities where. If two forces operate within the same jurisdiction (e.g., county sheriff’s department operates within a city which has its own police, or state capitol or parks police operate within a city), make a simple table showing how they divide responsibilities within the jurisdiction (e.g., city makes traffic stops, county escorts prisoners to court).
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Police Training 

• What baseline training in the law of criminal investigation 
does a police officer receive? 

• What kind of training do they get in handling biological, 
chemical, and radiation hazards, specimens and 
explosives (especially improvised devices)?  

• Are they trained in infection control? 
• What Personal Protective Equipment are they trained 

on? 
• Is in-service training in process or completed? 

 

Presenter
Presentation Notes
NOTES:Feel free to add additional slides to address answers to these questions for this law enforcement agency.  
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State Police 
or Bureau of Investigation 

• Roles  
• Field operations, detectives, forensic unit, bomb 

squad, HAZMAT team, etc. 
• Organizational structure 
• Points of contact  
• Capabilities  

 

Presenter
Presentation Notes
NOTES:Roles: In criminal investigations, what is role of local vs. county or state police or state Bureau of Investigation investigators in this jurisdiction? Organization -- how is this force organized – what specialized units are there, how do they relate to local and county law enforcement agencies, and to whom do they report?Points of contact: Provide phone numbers and other contact information for key persons or roles in the organization that public health, EMS, HAZMAT or fire might need to contact.  Capabilities: Describe state capabilities in criminal investigations – e.g., capabilities of state crime lab, specialized crime scene unit, how coroner or medical examiner services are provided, are there officers trained in PPE and entry into dangerous settings to gather evidence, sources of backup assistance for investigative activities as needed.  
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State Officer Training 

• What baseline training in the law of criminal 
investigation do officers receive? 

• What kind of training do they get in handling 
biological, chemical, and radiation hazards, 
specimens and explosives (especially improvised 
devices)?  

• Are they trained in infection control? 
• What Personal Protective Equipment are they trained 

on? 
• Is in-service training is in process or completed? 

Presenter
Presentation Notes
NOTES:Feel free to add additional slides to address answers to these questions for this law enforcement agency
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Federal Law Enforcement: FBI 

•  Roles  
– WMD Coordinator 
– Crisis Management Coordinator 

• Organizational Structure 
• Points of contact -- contact numbers for FBI 

WMD coordinator in that locale 
• Capabilities 

Presenter
Presentation Notes
NOTES:Do NOT use these slides if the FBI WMD coordinator will be presenting his or her own FBI presentation.Roles: In criminal investigations, what is role of local vs. county or state police or state Bureau of Investigation investigators in this jurisdiction, and how does this relate to Federal role? Organization -- how is the FBI  organized – what specialized units are there, how do they relate to local and county law enforcement agencies? How far away is your nearest FBI office, and your nearest FBI WMD coordinator?Points of contact: Provide phone numbers and other contact information for key persons or roles in the FBI that local or state law enforcement, public health, EMS, HAZMAT or fire might need to contact.  Capabilities: Describe briefly FBI capabilities in criminal investigations – e.g., capabilities of FBI crime lab, specialized crime scene unit and other resources, are there locally available officers trained in PPE and entry into dangerous settings to gather evidence.  
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Local Protocol for 911 Calls 

• Fill in based on your local protocol 
• Local protocol may route 911 call on BT threat or 

white powder to fire or HAZMAT first 
• Are some calls assessed as to credibility before 

sending a response unit? 

Presenter
Presentation Notes
NOTES:Customize to reflect local practice and procedures, as necessary.
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Response to 911 Call 

A common process: 
 

• 911 center receives call 
• Patrol unit dispatched 
• Arrival at scene – initial assessment 
• Determination if credible threat? 
• Advise communications 
• Notify Supervisor 
• May summon fire/rescue HAZMAT, EMS 
• Determine if evacuation is necessary 
• Is a secondary incident possible? 

Presenter
Presentation Notes
NOTES:Customize to reflect local practice and procedures, as necessary.
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Response to 911 Call  
(continued) 

• Supervisor arrives 
• Determines if threat is credible 
• If potential act of terrorism, this becomes a crime scene. 
• Field command post established in conjunction with 

fire/rescue, hazmat 
• Notification to local and state health, FBI 
• Hot zone, warm zone, and cold zone determined   
• Establishment of hot/cold lines 
• Further evacuation if necessary  
• Preserve crime scene 

Presenter
Presentation Notes
NOTES:Customize to reflect local practice and procedures, as necessary. 
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Criminal Investigation 
Process -- Initiation 

• How do police learn about crimes?   
• How do they decide which possible crimes to 

investigate? 
• Who decides that a crime has even occurred and needs 

to be investigated, for example in a covert BT event? 
• If an outbreak is recognized to be a likely BT event 

based on medical or public health suspicions, how does 
law enforcement get involved?   

Presenter
Presentation Notes
NOTES:This slide is used to describe how criminal investigation processes are initiated.
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Crime Scene / Warrants 

• How and when can police demand access to locations or 
information?  

• When is a search permissible without a warrant?  
• What are kinds of problems with searches lead to trouble in 

getting a conviction? 
• When and why is a location declared a crime scene? 
• When does a location stop being a crime scene? 
• Who decides when a criminal investigation should be 

stopped or suspended?   

Presenter
Presentation Notes
NOTES:The material to be presented in response to these questions may vary according to state and local laws and ordinances, or procedures. Feel free to use more than one slide. 
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Crime Scene Management – First 
Officer on Scene Responsibilities  

• Location treated as potential crime scene until 
otherwise determined 

• Officer arrives and assesses - assessment 
includes need for PPE 

• Assist victims/notify EMS? 
• Preserves scene with minimal contamination 

and disturbance of physical evidence 
• Officer uses caution, remains observant of 

persons, vehicles, and environmental condition 
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Crime Scene Management 
(continued)  

• Identify all individuals at the scene and isolate as 
necessary 

• Exclude all non-essential personnel 
• Document all persons entering and exiting scene 
• Establish perimeters and boundaries 
• Assess victims for medical needs 
• Assess the need for victim decontamination  
• Call for medical assistance 
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Crime Scene Management 
(continued)  

• Guide medical personal to victims to avoid 
contamination of scene 

• Point out physical evidence to medical personnel 
• Document any statements or comments by victims, 

suspects or witnesses 
• If transportation is necessary, officer accompanies 

to document comments and preserve evidence 
(utilizing PPE if required) 

Presenter
Presentation Notes
PPE: personal protective equipment
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Crime Scene Turnover 

• Scene turned over to investigators 
• Turn over brief conducted 
• Supervisor/investigators develop plans for 

notification in accordance with departmental 
policy - local, state and federal laws 
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Crime Scene Investigation by 
Detectives/Crime Scene Unit 

• Scene assessment 
• Walk thru and initial documentation 
• Determine team composition 
• Contamination control 
• Documentation (photos,videos, sketches, 

location of evidence 
• Prioritize collection of evidence 
• Collect, preserve, inventory, package, transport 

and submit evidence 
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Crime Scene Debriefing 
Team 

• Investigators, evidence techs, first responders 
• What evidence was collected 
• Where it goes for forensic testing 
• What decontamination requirements 
• Chain of custody 
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Gathering Evidence  

• Kinds of evidence police may look for in solving 
crimes: 
– Victim interviews  
– Witness accounts 
– Fingerprints, fiber, hair, organic residues, 

and other lab tests including DNA testing 
– Chemical, physical, biological testing of 

other materials from the crime scene or 
obtained through authorized searches 
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Gathering Evidence 
(continued) 

• Kinds of evidence police may look for in solving 
crimes: 
– Autopsy results and medical records (rape 

kit) 
– Paper records on or off site 
– Surveillance video footage  
– Answering machine messages 
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Chain of Custody 

Purpose of documentation is to be able to testify to: 
• Identity of investigator discovering material 
• Proper identification and marking of material on initial 

discovery – where found, nature of material, etc 
• No opportunity for tampering with material while in 

custody of any officials (e.g., proper container, locked 
storage) 

• Material in custody at all times as it is being passed from 
person to person, until it arrives in court 
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Chain of Custody 

• Failure to follow chain of custody procedures 
faithfully can result in evidence being excluded 
at trial.  

• How do agencies in this jurisdiction handle chain 
of custody requirements at a crime scene, and in 
other contexts?  

• Sample chain of custody form in binder 

Presenter
Presentation Notes
NOTES:If you have a story about a prosecution that failed because of chain of custody errors, especially one that got local publicity, tell the story.  
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Forensic Laboratory 

• Which crime lab does your agency use? 
• How do you get specimens to the lab? 
• What can this forensic laboratory do to support a 

criminal investigation? 
• Where do you get backup crime lab services?  

Presenter
Presentation Notes
NOTES:There should be a separate presentation about the forensic laboratory.  This is a place to quickly indicate which laboratory you use and how you get specimens to it. 
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Interviews 

• What are the general issues in interviewing 
victims, witnesses and suspects? 

• What the issues specific to joint public health 
and law enforcement interviews? 

• When are Miranda warnings necessary?  
• What kinds of problems with interviews lead to 

trouble in getting a conviction? 

Presenter
Presentation Notes
NOTES:If you have a local procedure for how to handle joint public health- law enforcement interviews, blessed by your agency attorneys, this is the place to describe it.  It should also be included in the participant binders.  If you have a story about a prosecution that failed because of chain errors in handling interviews, especially one that got local publicity, tell the story.  
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Interagency and 
Interjurisdictional Issues 

• How do local police handle investigations that cross city 
or county lines? State lines?  

• When do local police usually involve the state law 
enforcement agency in an investigation?   

• When and how do local and state police usually involve 
the FBI or other federal law enforcement agencies (ATF, 
Customs, Immigration, Secret Service, etc.)? 

• Sharing sensitive information between public health and 
law enforcement agencies. 

Presenter
Presentation Notes
NOTES:Re: information sharing.  If there are local procedures and protocols describing how and under what conditions sensitive information can be shared in both directions between law enforcement and public health workers, this is the place to describe them.  They should also be included in the participant binders. Feel free to use more than one slide if needed. 
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Evaluate Evidence  

• Determine if crime has been committed 
• Present to appropriate prosecutorial body 
• What evidence is available? 
• Witnesses? 
• Physical evidence? 
• Chain of custody? 
• To be determined — who has jurisdiction and 

who controls evidence? 
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Apprehend Suspects 

• Who decides whether to put a suspect under 
arrest? 

• At what point does a prosecuting attorney get 
involved?  
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Render Testimony  

• Who testifies? As to what? 
• How do you prepare for testimony? 
• What are common procedural errors that may 

reduce effectiveness of testimony? 
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Covert BT Events 

• Sometimes suspicion of a BT event comes from 
doctors or public health workers investigating 
outbreaks. 

• How and when does law enforcement want to 
hear from public health authorities about cases 
or outbreaks that could be BT events? 

• What protocols or MOAs are in place for 
initiating joint investigations in these situations? 
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Responding to a Biological 
Attack – Existing Joint Efforts 

• Existing: 
– Policies for interagency cooperation 
– Procedures for interagency cooperation 
– Memoranda of understanding (MOUs) 
– Memoranda of agreements (MOAs) 
– Joint training 
– Joint exercises 
– Coordination with local DoD installation 

Presenter
Presentation Notes
NOTES:Here you should indicate the extent of joint planning and joint exercises that have already been held that involve both law enforcement and public health at the local, regional or state level. Summaries of existing plans and memoranda of understanding should be included in the participant binder.  DoD: Department of Defense
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Joint Operations – Roles 
and Organizational Trees 

• Emergency Operations Center (EOC) 
• Incident Command System (ICS) 
• Joint Operations Center (JOC) 
• Joint Information Center (JIC) 
• Integrated Command System (ICS) 
• Unified Command System (UCS) 
• Joint Terrorism Task Force (JTTF) 

Presenter
Presentation Notes
NOTES:You may see fit to provide a separate presentation about Joint Operations or Emergency Management Procedures in your jurisdiction.  The point here is to indicate which of these the local law enforcement agency already participates in and/or has procedures for.  An explanation of the differences among JTTF, JOC, and EOC would be most helpful here.
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